
We have started this year’s theme Pas-
sion & Purpose with a bang. During our 
opening meeting September 21, Donna 
Maples was the speaker and WOW was 
she great.  Mrs. Maples is the administra-
tive assistant for The University of Ala-
bama President, Dr. Robert Witt. Mrs. 
Maples truly shared her purpose and pas-
sion for this profession. Mrs. Maples 
made this statement that really hit home, 
―she changes her work style to adapt to 
her employers style but she never 
changes her work ethics‖. 

Sometimes new administrative profes-
sionals come into an office expecting to 
change the environment and their boss 
who has been in their position for years.  
But your first assignment is to learn your 
surroundings which includes your em-
ployer’s work style and their expectations.  
Often not mentioned in position descrip-
tions is that you are asked to be a work-
place chameleon (a tree-dwelling lizard 
with long thin legs, a strong curled tail, a 
long sticky tongue-temperature indicators, 
and the ability to change color). Now, 
don’t start eating bugs and climbing trees. 
But as professionals we should have the 
ability to adapt and evolve in our environ-

ment just as a chameleon 
changes colors from green 
like the leaf to brown as the bark in their envi-
ronment.  I challenge you to become like the 
chameleon and change some of your work 
habits to match your employer’s,  Example, if 
you have an employer who is IT savvy, be-
come knowledgeable about all areas that 
deal with IT Technology; or if your employer 
uses a paper calendar and not Outlook as 
their main appointment source; begin using 
one too (which, by the way is a great backup 
system).  Learn your surroundings, adapting 
doesn’t mean that you are limiting yourself, 
but shows growth in your ability to grasp and 
flow with the environment you are in.  Then 
as you learn your employer’s needs and the 
working environment in which you find your-
self, you can gradually incorporate some of 
your ideas, to your specific area, to increase 
productivity and make you appear more like 
the chameleon. 

So, my advice for this month, ―Change your 
colors like a chameleon.‖  

Veronica Cross 
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The more you do, the more you're able to do. Your abilities grow stronger as you use 
them, so your best strategy is to get busy and use them. 

The feeling that you cannot do something is often powerful, and can feed upon itself. 
The way to get beyond it is with action. 

Any project you contemplate may at first seem overwhelming. That's understandable, 
because you haven't even taken the first step. 

Once you take that first step, though, the challenge begins to feel more manageable. 
As soon as you actually begin the effort, you also begin to get better at doing it. 

When the mountain is in the distance, it's difficult to imagine how you could climb it. 
Once you're on the path up the mountain, though, you'll always be able to easily see 
the next step and take it. 

Go ahead and begin the effort. Amaze yourself by discovering how very much you 
can do.   -- Ralph Marston  http://greatday.com/motivate/index.html#ixzz11zakVnnT 
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Julia D. Doherty 

Career Corner 

If you‘re annoyed at a co-

worker, don‘t complain to 

whoever happens to walk into 

your office. Instead, speak 

directly to the person with 

whom you‘re upset. This saves 

time and reduces the spread 

of ill will.  

 

Allot ‗worry time.‘ If you grow 

anxious thinking about all the 

work that awaits you, then 

reserve blocks of time to in-

dulge yourself in worry. Don‘t 

let these thoughts creep into 

the rest of your day—or you 

may wind up worrying about a 

job rather than doing it.  

The days aren't getting any 

longer—and your responsibili-

ties aren't getting any lighter. 

You need to get more out of 

every hour of the workday. 

 

Try setting aside 15 minutes 

after lunch as your private 

―worry time.‖ Have a pen and 

paper ready and list your 

anxieties, numbering them in 

order of importance.  

 

This exercise will help you 

clear your head—and maybe 

even reprioritize— so that you 

can return to work free of 

mental distractions. 

 

Anticipate first, reflect later. If 

you make a high-profile mis-

take, you may feel compelled 

to dissect what happened in 

excruciating detail. That‘s fine 

on your own time. But don‘t 

waste the day analyzing a 

screw-up or justifying your 

decisions to any and all who‘ll 

listen.  

 

Use that time to think ahead. 

Prepare for projects, such as 

rehearsing a big speech or 

gathering facts to include in 

an employee‘s performance 

review. Or call hard-to-reach 

people and leave a time for 

them to get back to you.  

Even the smallest interruption 

can disrupt your whole sched-

ule.  

www.businessmanagementdaily.com 

 

You want to make every hour 

count, so you plan your day in 

15-minute chunks and priori-

tize your tasks. That‘s smart 

time management, but it 

doesn‘t guarantee you‘ll work 

productively.  

 

You‘ll operate most efficiently 

if you capitalize on every min-

ute to produce fast, consis-

tently great results. That 

means turning plans into ac-

tion while banishing aimless 

anxieties and the urge to pro-

crastinate.  

How to Get Twice as Much 

Done in Half as Much Time 

Here‘s a road map to boost 

your productivity:  

 

Confront, don‘t complain. 

There‘s a time and place to 

vent your frustrations. But if 

you deplete precious time dur-

ing the workday by dropping 

what you‘re doing and talking 

about your irritations, you‘ll 

dig yourself in even deeper.  

 

 

How to get  

twice as much 

done in half as 

much time? 
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Julia D. Doherty– Executive Secretary  for Alabama 

Power Company for 27 years  

Member of IAAP since December 2006– 4 years 

Education– Graduate of West End Christian class 

of 1981 (She‘s a young lady)  

Married to Billy Doherty for 26 years 

Children/grandchildren– Two sons aged 23 and 19 

years old 

Julia loves to paint, watch her youngest son play 

baseball at the junior college he is attending and of 

course watching Alabama football—ROLL TIDE!!! 

Why I Love my job-‖When I first started working for 

Alabama Power Company in 1983, I had a variety 

of jobs.  I was a mail clerk; switch board operator, 

Customer Service Representative and an Ad-

ministrative Assistant.    Back then, I never 

imagined that later on in my career, I would 

become an Executive Secretary for the Western 

Division Vice President.   But here I am, 27 

years later, and it is the most rewarding and 

fulfilling job that I have had since I started work-

ing for the company.   I love what I do.   I enjoy 

coming to work every single day.  I love the peo-

ple, the variety of work that my job offers and  

flexibility the position offers. ― 

Favorite Quote- When you arise in the morning, 

give thanks for the morning light, for your life and 

strength.  Give thanks for your food, and the joy of 

living.  If you see no reason to give thanks, the 

fault lies with yourself.   TECUMSEH (1768-1813) 

Shawnee Chief  

MEMBERSHIP SPOTLIGHTS 

http://ezines.nibm.net/link.php?M=890030&N=12801&L=12993&F=H
http://ezines.nibm.net/link.php?M=890030&N=12801&L=12993&F=H


IT OFFICIAL 

Cari A Posey is married to  

Jeffrey Maddox Nichols 

Isn‘t she a  

beautiful bride? 

http://208.75.148.37/~momentsn/  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CONGRATULATIONS  

Christen  and Kevin Ballard  

Are expecting a bundle of joy 

May  7, 2011 

  

 

GOOD NEWS!!!!! 
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UPCOMING MEETINGS 
 

Tuesday, October 19, 2010 

Making it Clicking Between Managers and AP–  

Dana Langham, OfficeTeam, Birmingham 

Tuesday, November 16, 2010 

ENet-etiquette Skills 

Donald Malone, Manager, Web Development and Processes, UA, Student Affairs  

All meetings are held at  

JAMISONMONEYFARMER PC  

3rd floor Bank of Tuscaloosa Bldg.  

on 2200 Jack Warner Road Suite 300 

12noon—1pm 

Lunch provided $15 per person — Catered by Snap Decision Catering 

Contact Veronica Cross for information 205-394-6011 or vcross@crimson.ua.edu  

Missy Boshell—Sept. 8 

Cari Posey—Sept. 29 

Julia Doherty—Oct. 11 

MEETING INFORMATION 

http://208.75.148.37/~momentsn/


SOARING  

HIGH  

WITH 

IAAP 

Our Mission 
Enhancing the success of career-minded admin-

istrative professionals by providing opportu-

nities for growth through education, community building and 

leadership development.  

 

What are IAAP‘s core values? 

Integrity: We demonstrate this cornerstone of our profession through honesty, accountability and high ethical standards.  

Respect: We create respect within our profession and association through listening, understanding and acknowledging 

member feedback.  

Adaptability: We ensure the success of our association by embracing positive change and by nurturing diversity, creativity 

and visionary thinking.  

Communication: We cultivate and maintain excellence by remaining approachable at all levels, communicating openly and 

building strong relationships.  

OUR MISSION-IAAP 

Professional Certification Programs 

Admin Pro Newsletter 

Committee Participation 

Leadership Development 

JOIN IAAP-BECOME A MEMBER TODAY!!!! 

Tuscaloosa Chapter  

Increase your value by investing in your future. Membership in the International Association 

of Administrative Professionals provides outstanding benefits and services to meet your pro-

fessional and personal needs. The Tuscaloosa Chapter is a great resource to help you ad-

vance in your career, increase your skills and opportunities through networking, keep up with 

business trends and technology.  Achieve an improved professional image, outlook and fu-

ture with IAAP!! Chapter membership offers opportunity to develop skills in  

 

Benefits of membership include 

 

Organization management   

Budget Planning 

Public Speaking 

Leadership Development 
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The Six Steps to a Successful Career or Personal Reinvention 
 

by Marquesa Pettway, DTM 

You‘ve gone as far as you can in your job. Or you‘ve been laid off, in this still-down economy. In either scenario, you need to totally 

rethink what you‘re doing, and how you‘re doing it—you need to reinvent yourself. 

 

Reinvention is something we‘ll all experience several times in our lives, both personally and professionally. Every time we reinvent, 

we take our life to a new level—accomplish a new goal, go through a successful transition or be more aware of who we are and what 

we want. We experience reinvention during a job transition … when we turn an age older or younger … the first time we have a child. 

In other words, reinvention is part of living.   

 

When you follow my six stages to reinvention below, you‘ll find your entire life and is transformed—in the most positive way.    

 

Stage 1: Reflect 

We need to reflect on our lives in order to gain self-awareness, which answers the question: WHO am I?  We may think we know who 

we are, yet choose a job that goes against our values and skills, because we‘re desperate or because a friend has chosen that same 

career. 

 

To start this process I give people a self-assessment, called a ―self-profile.‖ This helps them look at their strengths and weaknesses, 

reflect on what‘s worked and what hasn‘t, and decide what their style is. The answers are important when it comes to making 

choices: should I work from home? Should I work for someone else? Should I buy an SUV? Even at age 60, you may not know what 

you want. 

 

About five years ago, due to corporate downsizing, I was laid off from my job. I‘d been promoted less than three months earlier, and I 

went through a meltdown. I also went through a reflection process. I spoke to an outplacement coach to figure out what I wanted. 

But before I could do that, I had to figure out what I didn‘t want. On a cruise with my family, I reflected on my life and realized that 

although I enjoyed marketing and sales, I loved something I did, but didn‘t get paid for: speaking. (My company held national con-

ventions, and guess who was the mistress of ceremonies?) I decided to become a professional speaker. I wouldn‘t have realized this 

had I not taken the time to reflect, and today I am living my dream as a national professional speaker.   

 

Stage II: Redefine. 

This stage is where you paint the picture of WHAT you want. Some people paint their picture by creating a ―vision board‖—cutting 

pictures out of a magazine and pasting them on a board to communicate to their wants to themselves. ―I think I want a job that in-

volves travel.‖ You may paste a picture of a plane on the board. You‘re not going to know all the answers at this stage; you will learn 

the ―What‖ – ―This is what I want, this is the kind of life I want for myself.‖ (I had done a lot of speaking; now I needed to figure out 

how to run a business as an entrepreneur.) 

 

Stage III: Refocus 

Now you start to lay out HOW you‘ll reach your goal. Every successful reinvention involves a plan. Do some research. Then, have a 

brain dump of everything you think you need to do. Make a big list, prioritize it and create goals based on your list. 

 

Make sure your goals are realistic and attainable. If you have bad credit, your first goal shouldn‘t be to buy a huge home. It should 

be, ―I need to clean up my credit.‖ Also make sure your goals are timely. Give yourself a specific time-frame: X will happen within the 

next three months, Y will happen in six months, and so on. This is a business plan for you.   

 

Part IV: Recommit 

Nothing we‘ve touched on so far will matter if you don‘t commit to the process. More of us will follow the rules of a cell phone con-

tract then of a contract we make with ourselves! For many years, I said to myself, ―I want to get my MBA.‖ But I procrastinated. I 

planned for it, but I didn‘t make a true commitment to myself. I didn‘t figure out ―How am I going to stick to my plan?‖   

 

One way to do so is to create a self-contract. Write ―rules of engagement‖ that apply to your situation and your goals into the con-

tract. Sign the contract, then find four more people—not family members; people who will hold you accountable—to sign the contract. 

This works because when we tell people our goals, we‘re embarrassed if we don‘t follow through. Two people who signed my con-

tract said, ―We‘re going to help you see this through.‖ 

 

 

PROFESSIONAL DEVELOPMENT  

Page 5 



Continued 

Stage V: Reenergize 

This is the ―WHY‖ of your goal. If you don‘t know why you want this you won‘t stick to it. This is mindset, and mindset is 90% of your 

success. You‘re focused and pumped and then week two or three rolls around and you decide not to get out of bed. 

 

You must put in place what will inspire, excite and energize you. I keep a circle of influence around me, individuals I spend time with. I 

call them my ―mastermind‖ partners; they keep me energized and excited. I read certain books. I track certain role models on social 

media. Everyone is motivated a different way.   

 

Stage VI: Reinvention 

You‘ve reflected, redefined, refocused and reenergized. The next question is: Where am I at now? If your reinvention was to move 

from corporate America  to your own business—now you‘re there. But you don‘t stop now. You set more goals, because you need to 

keep the business going. 

 

A Reinvention Success Story 

An admin who heard me speak told me she loves what she does; she just wanted to do it a different way. She did some research, 

which is part of the refocus step, and decided to start a virtual assistant business. (A virtual assistant is an admin who works virtually, 

assisting clients from a home office, over the phone, via email, etc.) But she didn‘t know the nuts and bolts of what that meant. After 

my presentation, this admin asked if she could learn more from me. I have three virtual assistants (VAs) and a program, the National 

VA Institute (nvai.com). She trained with me for about six months at the Institute, and now her business is up and running and she‘s 

working with entrepreneurs. That‘s a success story of an admin who went through a complete reinvention process. 

 

What will your success story be? Follow my six steps to reinvention and find out! 

 

Marquesa Pettway, DTM, is a reinvention expert, speaker and coach. For a reinvention map, go to reinventionsteps.com. To book 

Marquesa to speak, go to mlpspeak.com. 

PROFESSIONAL DEVELOPMENT  

Excel 2010 
 

1. Click File > Options > Advanced > Editing Options . 
Now, below the heading Editing Options you'll see After pressing Enter, move selection and below that, 
in the Direction drop down box is where you can make your choice. 

 
Excel 2007 

Same as 2010 but instead o f the File menu, , press the Office button near the File menu. 

 
Excel 2003 
 

1. Click Tools > Options > Edit tab.  

To change the direction in which the cursor moves, select the Move selection after Enter check box, and 
then select a direction in the Direction box. 

To keep the cursor in the current cell, clear the Move selection after Enter check box. 
 
(There's more information on all your options when moving the cursor here.) Now if you're using Excel 2010 or 2007, don't forget that 
you can add Options command to your Quick Access Toolbar for easy access. (Tip: When adding Options to the QAT, in the 

Choose commands from drop-down, choose File Tab; it's in there.) 

TECHNOLOGY BITES—Change where the cursor moves after entering data in Excel 
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Brainteaser AND Tips Admins always think on their feet.  

Match the country in Asia with the correct capital city: 

- Bangladesh 
- Cambodia 
- Indonesia 
- North Korea 
- Laos 
- Malaysia 
- Maldives 

- Yemen   

A. Phnom Penh  

B. Vientiane  

C. Dhaka  

D. Kuala Lumpur  

E. Jakarta  

F. Male 

G. Sana 

H. Pyongyang  

www.asaporg.com 

 

 

Finding Misfiled folders/documents 

1. Look behind the file folder or, in front, look under to see if it slipped through.  

2. Look in the actual file before or after the correct point. 

3. Look in a file with a similar name.  

4. Look in similar topics.  

5. If you recently filed it, look at the other files you worked on; maybe it got attached to the back of one (i.e. stuck on a staple 

or paper clip, etc).     www.deskdemon.com 

 

 

WORD FOR THE DAY 

ANESTHETIZE— 

Definition to administer an anesthetic to some-

body 

USAGE– You must anesthetize the gum before 

extracting the teeth.  

 

TIPS OF THE MONTH                                               

Eliminate Frustration and Create Clarity 
by Colette Carlson 

With the amount of to-do‘s growing daily, combined with the challenge of getting a supervisor‘s undivided attention 

and time, it‘s easy for admins to become confused and frustrated. Therefore, you may find yourself on the listening 

end of a fellow admin who is going on and on struggling to deal with the situation. You want to be supportive, but 

you also need to honor your own time constraints. When someone you care about is feeling overwhelmed, stop 

them and say, ―Tell me what you want‖ or ask ―What do you want to see happen in this situation?‖ This phraseol-

ogy immediately stops their downward slide and forces them to focus on an outcome that would make them feel 

happier or more satisfied. Then you can support them in looking for ways to make it happen. 
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NATIONAL BREAST CANCER MONTH— OCTOBER 2010 

 

 

 

Support and Remember a Loved One. 

 

NATIONAL BOSS DAY— OCTOBER 16, 2010 

 

 

National Boss Day is October 16 each year. When the holiday falls on a weekend, it is generally celebrated on the working 

day closest to October 16. 

National Boss Day offers employees an opportunity to recognize those in supervisory positions. Popular ways to say "thanks" 

include cards, a lunch in the boss's honor, flowers, or gift certificates. 

National Boss Day was started in 1958 when Patricia Bays Haroski, then an employee at State Farm Insurance Company in 

Deerfield, Ill., registered the holiday with the Chamber of Commerce of the United States. She designated October 16 as the 

special day because it was her father's birthday. Ms. Haroski's purpose was to designate a day to show appreciation for her 

boss and other bosses. She also hoped to improve the relationship between employees and supervisors. She believed young 

employees often do not realize the challenges bosses face in running a business. 

Mark your calendar for IAAP Fall Conference! 

OCTOBER 17-20, 2010 

Believe it or not, the end of summer is approaching fast, and it's time to start thinking about Fall Conference! This year's 

event will be held at the Hilton Seelbach Hotel in Louisville, Ken. This 2½ day conference provides opportunities to net-

work, share ideas, problems and solutions with other admins. You will have the opportunity to hear three to four top-

notch presenters and return to your job with renewed energy and vitality. You will also receive recertification points if you 

are an active CPS or CAP holder. For more information, visit www.iaap-hq.org/events.  

ANSWERS TO BRAINTEASER– Bangladesh-Dhaka, Cambodia-Phnom Penh, Indonesia-Jakarta, North Korea– Pyongyang, 

Laos-Vientiane, Malaysia-Kuala Lumpur, Maldives-Male, Yemen-Sana. 
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MARK YOUR CALENDAR  

http://www.iaap-hq.org/events

